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Gensym Release Notes 

March - 2012 

 

The information in this publication is subject to change without notice and does not represent a 

commitment by Gensym Corporation. 

 

Although this software has been extensively tested, Gensym cannot guarantee error-free performance 

in all applications. Accordingly, use of the software is at the customer’s sole risk. 

 

All rights reserved. No part of this document may be reproduced, stored in a retrieval system, translated, 

or transmitted, in any form or by any means, electronic, mechanical, photocopying, recording, or 

otherwise, without the prior written permission of Gensym Corporation. 

 

Gensym®, G2®, Optegrity®, and ReThink® are registered trademarks of Gensym Corporation. NeurOn-

Line™, Dynamic Scheduling™ G2 Real-Time Expert System™, G2 ActiveXLink™, G2 BeanBuilder™, G2 

CORBALink™, G2 Diagnostic Assistant™, G2 Gateway™, G2 GUIDE™, G2GL™, G2 JavaLink™, G2 ProTools™, 

GDA™, GFI™, GSI™, ICP™, Integrity™, and SymCure™ are trademarks of Gensym Corporation. 

 

Telewindows® is a trademark or registered trademark of Microsoft Corporation in the United States 

and/or other countries. Telewindows® is used by Gensym Corporation under license from owner. 

 

This software is based in part on the work of the Independent JPEG Group. 

Copyright (c) 1998-2002 Daniel Veillard. All Rights Reserved.  

 

SCOR® is a registered trademark of PRTM. 
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1. Introduction 

This document provides a list of the major features and enhancements added to the Gensym’s G2 2011 

Solution over and above the G2 8.3.r1 version. The reason to pick 8.3.r1 version over other releases was 

in part based on the current install base of our customers and their desire to find more information 

about the new G2 2011 release 

 

Please note this document is intended only as a summary document and the final feature set may 

change.  Please refer to the main release notes document - as and when they are released - for a 

complete detail on all the enhancements, features, functionality and bug fixes.  

 

The enhancements in functionality have been arranged into following sections: 

A. Platform Stack (section – 2) 

B. Feature Enhancements (section – 3) 

C. Layered apps quality enhancements (section – 4) 

D. Overall Quality Enhancements (section – 5) 

E. Enterprise Enhancements (section – 6) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Release Summary G2 2011 

 

 

Gensym Release Notes Summary           Page 5 of 18 

Copyright 2012 Gensym Corporation – All rights reserved           Gensym Confidential – Do not distribute 

2. Platform Stack 

Gensym 2011 version(s) will be certified on the following platform stack.  

 

 

3. New Features 

3.1.  Performance  

• In TWNG, grid view performance seems slow when initially adding rows to the grid when 

there is a large number of rows (>1000). Two new APIs routines g2-ui-grid-view-insert-rows 

and g2-ui-grid-view-update-rows are provided to update/add multiple gridview rows in one 

system call. This greatly improves this performance of the GridView control in TWNG. 

• G2 Server internal object/item relations management has been improved to provide faster 

runtime performance for any KB application using G2 relations. 

• Too many messages sent to Gensym Event Management (GEVM) queues cause G2 to slow 

down. Posting of messages to GEVM queues is now optimized for faster performance  

• A delay has been observed while connecting a TWNG client to the G2 server, due to the 

native log-book. New enhancements have been added  resulting in a faster connection with 

TWNG 

• In TWNG, the performance of the tree view population has been optimized for 

performance. With the new Tree View control it is now possible to add thousands of nodes 

to a tree in a short time. 
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3.2. Ease of Use 

3.2.1. G2 Server 

• A feature to allow procedure execution from the left-hand-side (LHS) of a rule is 

implemented 

• A new system API to find all affected procedures and rule texts when attribute names or 

class definition names are changed. The new API also includes a sequence of structures that 

contains the "starting" and "ending" positions of the affected text supporting g2-get-items-

affected-by-attribute-name-change" and "g2-renameclass-or-attribute" is required 

• New 128bit integer “long” data type in G2. Together with this new data type a new long-

parameter and long-variable class was added. 

• A new Feature which allows G2 user authentication based on OS standard like LDAP or 

Active Directory is implemented 

• A new feature to moderate aborts had been implemented; this feature provides a new API 

to have callback when g2 aborts happen. The server should run with command line “-use-

g2-abortcallback”. It tells the G2 server to call a g2-abort-callback instead of following the 

standard mechanism for G2 aborts. 

• When File->Save was chosen on a running kb only top level module could be saved. A new 

feature has been added so that the “Save” command now allows saving all user changes in 

all modules on a running kb as well by means of a new check-box in the Save dialog (TWNG 

only) 

• Half-width Katakana font encoding is now supported 

• Added the value-checking expressions from the G2 expression language to the G2GL 

expression language 

• Extended the limit for text values in G2 to 2MB 

• Two new system APIs to move (g2-move-file) or copy (g2-copy-file) a file, potentially across 

drives, has been added 

• A new feature to save a KB modules from G2 in XML format 

• Added “undo Delete” Feature. It is now possible to undo a deletion of an item in G2 

• Added  the ability to define user-mode aliases in G2 

• New APIs (e.g. to retrieve text, close the current editor, move cursor to the specific 

location) manage/control text edit sessions in G2 has been added 

• More robust kb loader with ability to detect and fix certain KB file corruptions 

• A new feature allows you to find out when your license will expire in the G2 title Block 

• Added scroll bars to native dialog boxes for easy navigation 

• G2COM - 50 connections limit could not be changed. A New feature has been added to 

make the connection limitless (-1) and a method provided to set it unique value 
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3.2.2. TWNG 

• A call back feature is implemented that gets called as soon as the selection is made on 

combo-box 

• The Validation procedure used to be called to validate the contents of a text box created by 

the GDU API but not when the focus is changed. A new Custom Dialog Control Behavior 

named focus-changed-custom-validate-control-value-procedure is added for gdu-add-

detail-button-control API enable validation when focus is changed 

• In TWNG, the support for word wrapping is added for native grid views and tabular views. 

• Two new duration controls have been added to the UI controls. New duration controls have 

the format "hh:mm:ss".  gdu-demo.kb contains usage examples 

• TWNG “Window” menu used to show only nine opened windows. A new feature in the 

form of a new sub-menu “Window ->More Windows” which would hold all other windows 

menu items but these nine 

• A new feature with the ability to change the font size of all application menus (View->Menu 

size) has been added 

• In TWNG, a new option to configure the background color of native dialog text box controls 

has been added.  In addition, 5 New APIs are added in the Gensym Dialog Utiltiy (GDU) 

module to support this feature. 

• In TWNG, a new system procedure to retrieve a client’s display dialog base units has been 

added. This allows for precise scaling and positioning of dialogs on any client display 

regardless of the display settings. 

• Automatic printing of Native windows 

• Enhanced formatting of dates in Date/Time controls. Now international date formats are 

also supported 

• New Operator Screen Configuration options. Adds new client window configuration options 

(i.e., move, size, maximize, minimize, views & panes, etc.) to improve Operator Screen 

interactions and user productivity 

• In TWNG, configurable grid-line colors for grid view controls has been added 

3.3. Connectivity 

• A new SQL Server database bridge based on OLEDB technology for Microsoft SQL Server 

2005 and 2008.  

• A new G2-Oracle 11 DB bridge is now included in the standard G2 bundle. 

• A new ODBC bridge supporting UNICODE characters is now part of the standard G2 bundle. 

• Java link used to work only with Java (JDK) 1.4. Now JavaLink is enhanced to run with Java 

(JDK) 1.6. 

• Support for DEP Security for G2Com. Updates G2Com to enable Data Execution Protection 

and prevent applications from executing malicious code 

• A new JDBC bridge has been added. JDBC is a java based database access technology to 

communicate with database 

• A new TW Control CAB file to easily deploy TW and TWNG clients over the internet 
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4. Layered App Quality Enhancements 

4.1. SymCure 

• On creating a method from “Fault Model” toolbox in Symcure gave “inconsistencies 

detected“  message on operator logbook. This no longer occurs. 

• Unicode support for SymCure CDG import-export feature has been added 

• In SymCure, a global variable is needed that returns true if the cgd engine is online or 

returns false if the causal directed graph engine is offline. This suggestion has been 

included 

• Symcure events could become inferred true after specified true. This has now been fixed 

• Events with 'Independent Of Effects' option on is upstream inferred false when its effects 

are set false. (SymcureUserGuide.pdf, Page No – 215) 

• Under certain circumstances, SymCure event propagation might incorrectly mark events 

suspect. This has now been fixed. 

• Under certain circumstances, SymCure events might spuriously change from inferred to 

specified. This has now been fixed 

• Independence of effects support with output fraction 1.0 on NM-NM events. 

• A topological sorting feature for the generic fault models in SymCure. Before topological 

sorting only existed for the specific fault models.  

4.2. Optegrity 

• Memory leaks were seen in Opegrity 5.1 if a .csv file containing data points is replayed. This 

issue is fixed 

• Objects created could be lost after saving and reloading the kb in Optegrity. This has been 

fixed 

• User-defined procedures and methods can’t be used. This bug is specific to Optegrity 

product. This issue is fixed 

4.3. Integrity 

• No indication of failure creating domain object from ping manager dialog. This is fixed. 

4.4. ReThink 

• In ReThink System attribute named class does not display in block input. This is fixed now 

• ReThink ignores needs-all-inputs attribute setting of blocks. This issue is fixed 

• The bpr-insert-block doesn't insert items into the container attribute of the container 

object in ReThink. This issue is fixed 

• ReThink: Under certain circumstances, a Rethink report may be updated only when deleted. 

This has now been fixed 

• ReThink: Under certain circumstances, a Rethink object cannot be loaded from file. This has 

now been fixed 
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• ReThink: If the Maximum Activities of a block are specified and work objects arrive at the 

block simultaneously, ReThink ignores the specification of Maximum Activities. This is fixed 

now 

5. Overall Quality Enhancements 

Based on issues reported by numerous customers and through our internal QA process, a number of 

quality improvements have been made across the platform.  Below is representative list of the 

product defects that has been fixed. They have been categorized by broad area where they have an 

impact. 

5.1. Aborts 

• G2 aborts when specific application that runs on 83R1 is loaded into G2 2011. This issue is 

fixed 

• G2 aborts when tabular-function-of-1-arg is called using a sequence or structure. This issue 

is fixed 

• G2 aborts on concluding the value of a nested structure that is an attribute of a class. This 

issue is fixed 

• G2 Server aborts on loading cdgmodguide.kb. This issue has been fixed 

• There was a hang observed in the application which uses G2Com. The hang is fixed in the 

current release 

• A G2 abort could be caused by too many GEVM messages. This has now been fixed 

• TWNG aborted when pie chart windows were continuously created and destroyed in 

charts.kb. This problem has been resolved 

• Repeatedly calling G2-send-soap-request could cause a segmentation fault. This has now 

been fixed 

• G2 used to abort in some instances after loading a snapshot. This abort is now fixed 

• TWNG might crash after several million continuous property changes to a tree view. This 

has now been fixed 

• Under certain circumstances, deleting all workspaces of a module can cause G2 to abort. 

This has now been fixed 

• TW would abort because of running out of pix-maps when it is repeatedly rerouted. This is 

fixed now. 

•  In the data-server-aliases of data-server-parameters, adding "none" to the list of aliases 

would cause g2 to abort. This issue has been fixed 

• Trend-chart aborts g2 when lower-bound > upper-bound. This is has been  fixed 

• Certain operations involving selection UI and inspect might cause an abort. This is has been 

fixed 

• G2 or TW displaying on a Windows platform may abort when the available memory for 

graphical objects is exhausted. This is issue is now fixed 

• G2 would abort with bad value for identifying attributes of interface. This issue is now fixed  

• When we put the image-definition on the sub workspace of the media bin, g2 would abort. 

This issue is now fixed 
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• Rule compilation might abort g2. This issue is now fixed 

• G2 abort when using trend-chart. This issue is now fixed 

• G2 was aborting when doing a application reset. This issue is fixed now 

• TWNG aborts when we close any of the demos displayed in GRPE demo. This issue now 

fixed 

• g2 would abort after undo-workspace was executed – this is now fixed 

• Re-populating of an existing shortcut bar using the g2-ui-manage-shortcut-bar function 

resulted in a G2 abort. This is now fixed 

• G2 Enterprise: G2 abort when 4th argument in function kbf-g2nke-count-history-matching-

op contains float value. This is now fixed 

• Abort when clicking on item table or shortly thereafter, this issue is now fixed 

• In some occasions G2 would abort when using system procedure g2-read-bytes-as-

sequence. This issue is now fixed 

• If new KB is loaded without shutting down the old one, in some instances G2 would abort. 

T his is now fixed 

• G2 would abort on calling APIs g2-get/set-hash-table-value with negative key. This issue is 

now fixed 

• Sometimes the use of radio buttons in TWNG native dialogs cause hang of TWNG 

• G2 8.0 Demonstration kb - Textual display formats. - Deleting a workspace with a text 

editor open for a type-in-box aborts G2 during G2 shutdown. This is now fixed 

 

5.2. Memory Leaks 

• GEVM messages could cause memory leak while inserting messages. This has now been 

fixed 

• Memory leak could occur when using hash tables. These leaks have been stopped 

• Memory leaks could occur in the TWNG under certain circumstances. These leaks have 

been stopped 

• A GSI memory leak could occur while using gsi.dll – this has now been resolved 

• Anytime TWNG is showing a G2 workspace, the number of GDI processes grows. This leak 

has been stopped 

• Using GSI via .Net interoperability might result in a memory leak. This has now been fixed 

• G2 could leak memory when applying the function symbol. This has now been fixed 

• TWNG might leak memory when showing and hiding workspaces. This has now been fixed 

• TWNG might leak tooltips when associated tree view nodes are deleted. This has now been 

fixed 

• Creation and deletion of combo boxes might leak memory. This has now been fixe 

• Certain toolbar operations might leak memory. This has now been fixed 

• Memory Leaks in G2 Graphical Language (G2GL) while compiling procedures. This issue is 

fixed 
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• When memory is consumed by messages and workspaces created by g2- save-module API. 

A new API routine "g2-reclaim-save-module-memory” is introduced to reclaim the 

consumed memory 

5.3. Ease of Use 

• G2 was calculating the “uninterrupted procedure execution” differently than expected. This 

has now been fixed. Now the uninterrupted execution is calculated as follows. For each 

invocation of procedure A, we add up the time spent actually executing procedure A, not 

including time spent doing other things (if A allows other processing) or executing other 

procedures called by A. If this exceeds the uninterrupted procedure execution limit for 

procedure A, we signal an error. A new option is added to the “Miscellaneous Parameters” 

system table named “Calculate time of called procedures” which will allows to switch off 

the fix. 

• If a workspace view currently has scroll bars, then moving the workspace via the "show 

workspace" action to a position completely outside the view may shrink the view to zero 

size, leaving only a title bar. This issue is fixed. 

• It was not possible to launch a native editor as modal. This issue is fixed 

• Whenever we edit a method using native editor only the top signature is animated in blue. 

The issue is fixed 

• Special characters like "@' were not visible after editing and saving text. These characters 

are now visible 

• On rotating (90 degrees or -90 degrees) "text in icon" objects upon a workspace and typing 

Ctrl+W (Twenty percent wider) or Ctrl+N (Twenty percent narrower) several times, the 

texts in icon were disordered. They are now displayed correctly 

• The Y axes of multiple charts could not be aligned in the native chart view. Multiple charts 

now have aligned axes 

• NM-NM event sensitivity has been made more flexible. Now we can specify delay required 

in propagating the value. 

• API "send-fault-model-event" has been published  

• When using a dialogs with Icon button in TWNG, the .chm help file is appearing at the back 

the TWNG. This should appear as the first item. This Issue is fixed. 

• A new control action sort-rows has been added to re-sort rows of tabular views 

• New Gensym Events Management (GEVM) message entries would always be added to the 

end of GEVM queues. An attribute sort-views-upon-update has now been added to make 

this behavior configurable. 

• It was not possible to determine programmatically whether a class can be instantiated. This 

can now be done by reading the attribute instantiate. 

• G2, when invoked in classic UI mode, did not support certain UI configuration options. This 

has now been fixed. 

• Genflex – Would have some problems  to run on Windows 7 (64 bit) – this is now fixed 
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• Genflex - Syntax highlighting gets easily out-of-sync with the procedure text. This is now 

fixed 

• Genflex - Property panel not automatically updated for attributes changes, this is now fixed 

 

5.4. Bridges and Connectivity Improvements 

• ODBC bridge aborts when a sql query using a bind variable prefix is passed to the 

procedure db-sql-function, and no bind variable is defined. The abort is fixed by 

implementation of error handling. 

• The HLA bridge did not display its version. This has now been fixed. 

• Terminating the g2-opc client window generates an "end now" button. This is fixed now. 

• Self-Registration error while installing G2, G2com didn't self-register. This is now fixed 

• In some instances G2Com interface was neither permanent nor transient resulting in failure 

when saving the KB. This now fixed 

5.5. Other Improvements and fixes 

• G2 becomes sluggish when switched to fast as possible mode after real time mode. This 

issue is now fixed 

• A g2-window object might incorrectly persist after unexpected termination of TWNG. This 

has now been fixed 

• Saving operation on a kb failed when a backup kb is present at the saving location. This 

issue is fixed. 

• The port number is changed to 20000 on clicking user menu choice connect in G2 database 

interface. This issue is fixed 

• TWNG ignores "rolling the mouse wheel {forward / backward} and does nothing" when 

displaying html-view 

• Errors in UIL on loading the application due to improper error handling. This issue is fixed 

• Field level validation is called twice if we create a native text box using gdu-add-text-box-

control () and specify a validation procedure. This problem is fixed 

• Developer code was left over in sys-mod.kb. This has been resolved 

• Native dialog always appears in primary display even when TWNG is used in dual-display 

environment. This issue is fixed 

• The changes to GRTL-MODULE-SETTINGS object get overwritten after KB start/restart. This 

issue is fixed 

• When an object is moved across the screen it leaves "tracks" or shadows. This issue is fixed 

• G2 and TWNG used to freeze when adding to the order of 100,000 nodes and deleting 

them. The problem is fixed by optimizing G2 and adding a faster tree control in TWNG 

• The attribute "multi-axes-proportions" did not work in Chart Views. It now works as 

documented. 

• Under certain circumstances, having a user with a password that never expires might result 

in an invalid OK file. This problem is now resolved. 
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• When g2-ui-launch-editor is used to open a G2 editor and If you start typing a word and 

click "control-spacebar", you get a pop-up with the entire list of completed keywords even 

ones that have been excluded. This problem has been resolved 

• System procedure g2-nms-dismiss () did not dismiss opened menu as it was supposed to do. 

This has now been fixed 

• G2 displayed the "tile-vertically" menu for TWNG incorrectly in non- English locales. This 

has now been fixed 

• Changing the gsi-interface-name of this gsi-data-service from one valid interface-name to 

another valid interface-name (or even if we just re-conclude it) caused the gsi-data-service 

to be is dropped from the item-list. This no longer occurs 

• When the workspace-scaling of the printing-detail of the system-table printer-setup is set 

to something else then 100, then the output from g2- ui-print-workspace () to a jpeg file 

was garbled. All scales are now correctly supported in the output 

• Checkmarks on GMS menus did not work in TW and TWNG. They did not show up in TW 

clients, but they still worked in the G2 server. They now appear in TW & TWNG as well 

• When opening two or more connections to a java socket, disconnecting one will stop data 

flow in all connections. This has now been fixed 

• NeurOnline -TWNG could emit an error while making data-set permanent when count 

increases more then 100. This has now been fixed 

• Menu bar reappeared even though it was hidden. This has been fixed 

• The support for printing native dialog is added in this release. Support for certain controls is 

be added in G2 bundle 

• If two dialogs are displayed one after the other in TW, closing the second one before the 

first could cause an error. This has now been fixed 

• After hiding the workspace of a trend-chart, data-window-time-span of which were several 

weeks or more and redisplaying it, the early part of plots could be lost. This has now been 

fixed 

• g2-ui-get-selected-window-handle procedure signaled an error when local window was 

selected. This error has been replaced by the message "This operation cannot be 

performed on a g2 local window" 

• The Order Selection 1-2 and 3-4 for D1 and D2 do not work even if sort direction and sort 

criteria are set. Build Selection 1-2 and 3-4 for M1, M2, M3 and Mb do not work too. These 

blocks always select orders in LIFO regardless of actual settings of the Order/Build selection. 

This issue is now fixed 

• State transition of NM-NM event with option is not consistent. Events were changing to 

Inferred true/false during propagation even after specifying the value of event. This Issue is 

now fixed 

• TW did not start from the command line if the command line length is too large. This issue 

is fixed 

• Inconsistencies in the Protools call tree and inspect call tree function where some of the 

called procedures were missing from the call tree. This issue has been fixed 
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• "Independent Of Effects" option for "AND" and "N/M” events, Where setting this value 

from the event properties make the event independent of its effects 

• Protools could not find unused variable if appropriate call is commented. This issue has 

been fixed 

• A bug in the Gensym Run Time Library (GRTL) knowledge base file, which relates to 

connecting to the G2 Server when KB is not fully loaded resulted in loaded application main 

menus (File, Edit, etc.) to become empty. This bug is fixed 

• Inconsistencies in Gensym Diagnostic Assistance (GDA) application menu, where 

"application" was not shown in TWNG. This issue has now been fixed 

• There are several instances of the Error Queue come up on application startup, apparently 

one per error message logged. Each view shows the same list of error messages. It is also 

true for custom queues. This issue is now fixed 

• Restricting access to a root menu template based on user mode was not working. This issue 

is fixed 

• Making a matrix permanent could result in an error. This has now now been fixed 

• The message queue popup menu and toolbar might not be updated on user-mode change. 

This has now been fixed 

• When a tree node is deleted, its children might survive. This has now been fixed. 

• Under certain circumstances, the color of tree-view icons may not be updated. This has 

now been fixed 

• Under certain circumstances, string comparison inside a G2GL switch fork condition could 

be case-sensitive. This has now been fixed 

• Under certain circumstances, G2 might generate unreadable PostScript files. This has now 

been fixed 

• The system limit of 130,000 native icons might be spuriously exceeded. This has now been 

fixed 

• The number of GDI processes might unduly grow in certain circumstances. This has now 

been fixed 

• Under certain circumstances, combo box callbacks might be incorrectly invoked. This has 

now been fixed 

• Under certain circumstances, icons might be updated with incorrect images. This has now 

been fixed 

• The call g2-ui-print-workspace did not respect the JPEG quality parameter. This has now 

been fixed 

• The CDG module might intermittently display a spurious message. This has now been fixed 

•  Certain control keys may not be recognized with the caps lock on. This has now been fixed 

• Under certain circumstances, Protools may not find a called method. This has now been 

fixed 

• Under certain circumstances, viewing a disabled class definition might cause an error. This 

has now been fixed 
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• Selecting the launch procedure menu choice of a procedure, does not do type checking to 

be performed for arguments of type truth value. The result defaults to False. This is fixed 

now 

• Gensym Menu System (GMS): GensymAccelerator labels are not displayed in native menu 

of gms-choice-template. This is now fixed 

• Gensym Event and Data Processing (GEDP):  gedp-quotient-block might not be connected 

to an upstream block. This is now fixed. 

• The call-tree feature in Protools doesn't recognize // as a comment. This is fixed and now it 

recognizes // as comment 

• Inconsistencies when loading the NeurOnline (NOL) module. This is now fixed  

• Incomplete items when loading gda-tank demo. This is fixed now 

• Alt Keys were failing with Caps Lock on. This issue is fixed 

• Rendering in TWNG is suspended by opening combo-box and leaving it in Windows XP SP-3. 

Any screen refresh of workspaces is halted while the combo-box is open. This issue is now 

fixd 

• g2-ui-cancel-custom-dialog fails canceling dialog – this issue is now fixed 

• System procedure G2-Get-Network-Address-List() does not work in Linux. This issue has 

been resolved 

• Presence of wrong uncolored icon in GMS menu- reproducible only on Win XP SP-3. This 

issue now fixed 

• TWNG would stop drawing in simulated time or as fast as possible mode, this issue is now 

fixed 

• Cyrillic characters could not be displayed on menus this issue is now fixed 

• Grid-views: cells could not be replaced with a cell including an ellipsis-button. This is now 

fixed 

• Title bar icons show up as black squares in TWNG. This issue is now fixed 

• Images with anchors were disappearing during resizing of dialog. This is now fixed 

• The native calendar control in TWNG invokes two update callbacks when one is expected. 

This is now fixed 

• Gensym Excel  (GXL) no longer supported default setting of colors for cells in G2 2011 – this 

issue is now fixed 

• The Percent-run-time G2-meter is not working correctly by showing wrong percentage of 

G2 execution time. This has now been fixed  

• Wrong toolbar button appears at the first creation of toolbar. This issue is now fixed 

• New feature to capture the mouse location in a call back - Native Chart Callback Mouse 

Location – has been implemented 

• G2.ok file parsing error no longer written to standard output. With a fix the out put is 

directed standard output 

• Windows 7: Can only launch a TW client from the start menu, when running it as 

administrator.  Admin privileges are no longer required to launch TW. This has been fixed 
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• G2 authorization 'sees' strange non-existent machine id under Linux. This caused that the 

machine-id in the G2.ok file was not recognized by G2 resulting in license issues on G2. This 

is now fixed 

• Linux: In rare instances, while loading some applications some ‘Item’ attributes contain 

strange values after load. These values are now properly initialized 

• In rare instances, individual KB modules were getting saved in an inconsistent way with 

respect to the defined module hierarchy. This issue is now fixed 

• Images in image controls contain black areas. This issue has been fixed 

• Images in grid views show up as black squares. This issue has been fixed 

• Gensym Excel (GXL): problem with GXL API gxl-set-color-pattern-of-cell-to-default would 

not correctly set the default color – This API function has been fixed 

• When switching user mode (e.g. from administrator to user) Gensym Menu System (GMS)  

would not correctly display the customized menu, it would change to the default menu – 

this is issue is now fixed 

• Strange error message posted in the logbook during G2 shutdown: "Invalid pathname 

argument for the byte code profiler" – This issue is now fixed 

• GDU Demo - Dynamic Dialog Specification - example was not working. This issue is now 

fixed 

• Transparent regions of icons are wrongly painted as black in Shortcut-bar. This issue is now 

fixed 

• Inconsistencies in connection expressions when connections contain (sub-workspace) 

connection posts. This issue is now fixed 

• Chinese character can't be displayed in G2 2011. This issue is now fixed 

•  g2-add-user () procedure generates an incorrect g2.ok file. This is now fixed 

• Background images are showing up as black squares, this issue is now fixed 

• In rare instances, TW was not opening on Windows 7 32 bit PC. This issue is now fixed 

• Using User Interface Library (UIL)/Gensym User Interface Development Environment 

(GUIDE) dialogue edit-box colors were not restored after disabling and enabling dialogue 

edit-box.  This issue is now fixed 

• Genflex - Editor doesn't work for new and existing procedures after loading mill demo. This 

issue is now fixed 

•  Genflex – In rare instances, the Inspect facility was not working as expected. This issue is 

now fixed 

• Genflex - The editor inserts strange characters in the procedure causing corruptions in G2. 

This is now fixed 

6. G2 2011 Enterprise Features 

6.1. Support for Linux 

The enterprise version of G2 is now supported on Linux 5.6 platform along with all the 

necessary bridges and interfaces.  Migrating from an older version of Linux or (Unix like 
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operating system) is possible as KBs are platform independent and will continue to work on the 

new platform. 

6.2. Support for x64 bit platform 

With true 64 bit addressable memory the G2 platform now has limitless memory addressing 

capability (surpassing the 32bit 2G limit) which is only limited by the available hardware. This 

feature is particularly useful when you are dealing with thousands of assets (e.g. even stream 

data from network nodes).  

JDBC, ODBC, JavaLink, GSI bridge are currently 64 bit compliant with work is in progress on 

other less frequently used bridges  

6.3. KB optimization 

As part of enterprise, Gensym offers a unique service that allows you to optimize the 

performance of your KB’s by several orders of magnitude. The targeted service requires a small 

amount of collaboration from the client to identify processing bottlenecks and conduct some 

profiling of the KB using inbuilt G2 tools.  These bottlenecks are then resolved by a combination 

of techniques such as converting the procedure or a methods into a native system call, which is 

written in program language (e.g. C), which then executes natively without an interpreter.  

6.4. GenFlex  

Enterprise version of G2 comes with a more user friendly client to build and write applications 

using a Visual Studio like motif, with productivity tools like intelli-sense type ahead completion 

for G2 language, improved run-time error logging through the development console, code and 

rule separation from workspaces 

6.5. Enhanced TWNG User Interface 

The enterprise version of G2 comes with an enhanced TWNG, with a more user friendly 

‘windows-like’ UI and visually pleasing and well contrasted icons that are more discerning to 

your eyes 

6.6. Native Enterprise Performance improvements 

Indexed Attributes:  

Enterprise comes with implementation of an improved version of the commonly used Indexed 

Attribute data structure. The performance gains we have observed when doing a hash lookup 

using the new indexed attribute lookup is 10x to 20x. If you application is using this data 

structure, then you will clearly benefit for this innovation 

RPC over head: 

The RPC overhead has been improved in the Enterprise version by 15% to 20%. This has 

significant impact because it significantly improves the external communication that G2 

performs using many of its bridges. Any KB relying on RPC (Remote Procedure Calls) for data 

acquisition for delivery will benefit for this enhancement 
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Data Types: 

New float and integer array types (Native Arrays). These arrays are more efficient in accessing 

elements 

CUDA Bridge: 

Compliant with NVIDIA’s Compute Unified Device Architecture (CUDA),  a graphical processor 

unit (GPU) bridge that allows for the execution of programs on the GPU directly from G2.  

CUDA is a parallel computing platform and programming model invented by NVIDIA. It enables 

dramatic increases in computing performance by harnessing the power of the graphics 

processing unit. 

6.7. Areas of R &D Focus for Enterprise 

As part of the renewed focus on enterprise Gensysm’s development team is currently working 

to incorporate several new innovations into the G2: 

Multi-Threading: 

The focus with innovation will be ensuring that G2 can deliver high performance by utilizing 

multi-core architectures of modern chipsets. There are two approaches Gensym is currently 

focused. 

First, where we introduce native threading in a G2 scheduler so that internal processes are 

allocated a new thread, context and access to shared memory. This innovation will allow G2 to 

take advantage of the multi-threading capabilities right out of the box.  

The second approach is to provide a Threading capability by way of an extensible API. This will 

provide the designers of G2 applications to decide for themselves how they would like to take 

advantage of the G2s threading capabilities. With the second approach the current applications 

will not multi-thread automatically. The designers will have a repertoire of tools, basic inbuilt 

data structures and constructs to extend their current application to take advantage of multi-

threading.   

GSI Performance 

The focus of this innovation is to drastically improve the performance of the most common 

layer within the existing bridges. This is the Gensym Standard Interface (GSI). The idea here to 

offload some of the GSI processing (i.e. data marshalling, serializing etc.) onto a different core 

of the CPU, similar to the way TCIP offloading is done in modern integrated chipsets (i.e. TOEs 

or TCPIP Offloading Engines)  


